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Renesas Synergy™ S124  

Sensor Panel Board User Guide  

Introduction  

This User guide describes about the Renesas Sensor Panel Board. In this Sensor Panel solution, Renesas Synergy™ 

S124 Microcontroller Group and Renesas RL78/G1D Bluetooth Low Energy (hereafter called BLE) are the highlighted 

Components. Using this Sensor Panel Board, developers can easily start to evaluate on Renesas Lighting solution, using 

RL78/G1D Bluetooth® wireless connectivity and Renesas Synergy™ S124 device including Temperature sensor, Light 

sensor and necessary user interface.  

Target Device  

R7FS124773A01CFM  
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1. Overview 

The Sensor Panel Board uses the Renesas Synergy™ S124, 32-MHz Arm® Cortex®-M0+ microcontroller with 256 KB 

of code flash, 24 KB of SRAM, and 4 KB of data flash. It has two push button switches, one reset button, and three 

LEDs for user interface; Bluetooth® RY7011 module and onboard micro-B USB for communication; and one PMODTM 

connector for expansion. For interacting with surrounding environment, it also includes Temperature Sensor, Light 

sensor, passive infrared (PIR) sensor, Reed Switch (Tilt Switch) with two LED indicators, Hall Effect Switch, and two 

open drain outputs. There are a 5 volt center positive DC power connector (cylindrical male diameter 5.5mm) and the 

same micro-B USB connector from external power and has internal power supply provided by Li-ion Battery (Type: 

NCR18650BF or equivalent) with battery charger including 3.3 volt regulated output to provide onboard power. For 

development, the board has two Programming/Debugging contactors: standard 9-pin JTAG contactor for S124 device 

and 14-pin (2x7, 0.1 inch) connector for RY7011 module. Two 4-screw terminals are included for two general purpose 

switch inputs and two open drain output as well. 

Figure 1 shows top and bottom view of the Sensor Panel Board. 

 
 

Figure 1  Sensor Panel Board 

1.1 Specification Outline 

The specification of Sensor Panel Board is described as below Table 1. 

 

Table 1  Sensor Panel Board Specification 

 

Item Content 

Dimension 3.25 inch x 4.725 inch 

Mounting Hole Dimension 2.650 inch x 3.375 inch, Φ ⅛ inch 

Operation Power Supply Voltage 5.0 V  

Maximum Power Supply Current 100 mA 

Operating Ambient 

Temperature/Humidity 
0C to +60C, 10% to 80% RH (non condensing) 

 

  



Renesas Synergy™ S124 Sensor Panel Board User Guide 

R12AN0074EU0100  Rev.1.00  Page 3 of 19 

Nov 15, 2017  

2. Sensor Panel System 

Figure 2 shows the Sensor Panel System Block diagram. Typically the Sensor Panel board has five sections: Renesas 

Synergy™ S124 microcontroller (MCU), Bluetooth®, user input/output, Sensors, and regulated power supply with 

battery. Renesas Synergy™ S124 device is populated along with RL78/G1D BLE module (RY7011). Thus the 

acquisition of data from sensors are processed by S124 device and then transmitted through the Bluetooth® module 

RY7011. To connect with external device like thermostat, it has two digital inputs and two open drain outputs for 

controlling the device. In addition, there is one 12-pin PMOD™ connector so that you can utilize on adding more 

sensor like Accelerometer or LCD display. You can also monitors the environment parameter using board sensors like 

temperature, light, PIR, reed switch and Hall Effect switch. The Sensor Panel board is suitable to evaluate and develop 

various sensor applications with S124 device. Using slide switch (S5), the Sensor Panel board can be powered up with 

Li-ion battery or external power source. 

 

Figure 2  Renesas Synergy™ S124 Sensor Board System Block diagram 

2.1 Renesas Synergy™ S124 device 

This Sensor Panel board uses JTAG programming/debugging interface for S124 device. The JTAG signals can be used 

through JTAG connector (J1). Use the SEGGER J-Link for programming to the board and debugging for development. 

See detail in schematics sheet 2 of 6. 

Table 2 JTAG 

 

To enable JTAG debug with S124 target on the Sensor Panel board, use with jumper JP1 for boot mode as below.  

 Insert shunt jumper at JP1 SCI boot mode (serial programming mode).  

 Remove shunt jumper at JP1 Normal boot mode. 

2.2 RL78/G1D module (RY7011) 

This RY7011 is a Bluetooth Low Energy module incorporated with the RL78/G1D device, 32-MHz crystal resonator 

for the RF section, and PCB antenna. This module has been certified on Japan’s Radio Law, FCC certification, IC 

regulation, CE mark requirements, and the Bluetooth v4.1 specification. Thus it is suitable to use on Sensor Panel board 

yet low power consumption as below: 

 RF transmission: 4.3 mA (TYP.) 

 RF reception: 3.5 mA (TYP.) 

 RF sleep (POWER_DOWN mode): 0.3 μA (TYP.)  

JTAG Description 
Renesas Synergy™ S124 Microcontroller 

Function Name Pin 

Test Mode Select TMS/SWDIO P108 (P1_8)  

Test Clock TCK/SWCLK P300 (P3_0) 

Test Data Out  TDO P109 (P1_9) 

Test Data In  TDI P110 (P1_10) 

Reset  RESET# RESET#  

S124 
MCU 

RL78 BLE 

module Li-ion Battery and 
Regulated 3.3 volt  
Power Supply rail 

Temperature Sensor 

Light Sensor 

User Switches 

LED Indicators 

Open Drain outputs 

Reed Switch 

Hall Effect Switch 

Current Sensor 

Li-ion Battery Charger 

S124 Sensor Panel board 

PMOD 

DC Power Jack 

E1 Debugger 

Header 

USB 

JTAG Ports 
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3. Building Sample Project 

3.1 Renesas Synergy™ S124 Firmware 

This Sensor Panel board populates with Renesas Synergy™ S124 microcontroller to evaluate with onboard sensors. 

Thus, Sensor Panel board can be used as development platform. When using this Sensor Panel board, PMOD™ module 

can be added for extended feature through UART or CSI peripheral. For debugging and programming to S124 device, 

you can use JTAG connector (J1) with SEGGER J-Link debugger. For using S124 programmer/debugger tool and detail 

project development, refer Renesas website.   

(Note: SEGGER J-Link download link: https://www.segger.com/downloads/jlink) 

 

Figure 3  Renesas Synergy™ S124 Hardware Programming/Debugging setting 
 

In order to build and debug the Renesas Synergy™ S124 firmware, you need e2 studio version 5.3 or later and Renesas 

Synergy™ Software Package (SSP) 1.20. To begin debugging, import the project (s1_Sensor_board_01) from the 

following folder. 

\..\ Renesas_Sensor_Panel_Demo\ Synergy_project\S124. 

https://www.segger.com/downloads/jlink
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Figure 4  e2 studio Workspace environment Import Projects 

3.1.1 Importing the Renesas Synergy™ Project in e2 studio Workspace 

To import the project into e2 studio workspace, following the below step 1 to 5. 

1. First, launch the e2 studio workspace.  

2. Select Import from the File pulldown menu.  

3. Select Existing Projects into Workspace from General, and click Next.  

4. Browse the projects folder, select the files, and click Finish.  

5. Clicking Workbench in the Welcome screen opens the Workspace (see Figure 5) and selects Build All (to 

build all the projects) from Project pulldown menu. 

 

Figure 5  e2 studio Workspace environment 
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3.1.2 Debugging the Renesas Synergy™ Project in e2 studio Workspace 

1. To enable JTAG debug function on the S124 Sensor Panel board, do the following (see Figure 3). 

The S124 Sensor Panel board uses JTAG as its programming/debugging interface. Insert shunt jumper at the 

JP1 location (ON position) on Sensor Panel Board.  

A. Attach the J-Link connector (J1) to the SEGGER J-Link debugger unit.  

B. Supply power to the Sensor Panel Board using provided battery or +5 VDC Power via USB micro-B (J2).  

Figure 3 shows the debug setting with SEGGER J-Link debugger. 

 

Figure 6  e2 studio workspace debugging setup 

2. Set the Debug configuration by selecting a project to debug. 

3. Figure 6 shows the Debug Configuration window.  

4. Select Debug Configuration from the Run pulldown menu.  

5. Right-click Renesas GDB hardware Debugging.  

6. Select New from the options menu to create a new debug launch.   

7. Select the Debugger tab (see Figure 6).  

8. Select Arm’s J-Link for debug hardware and R7FS12477 for Target Device.  

9. Click Debug to start debugging.  

Figure 7 shows the Debug window. Click Resume (F8) to run the program in Debug mode. 
 

  

Figure 7  e2 studio workspace in debugging mode for Renesas Synergy™ S124 
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3.2 Renesas RL78/G1D Firmware 

This Sensor Panel board populates with Renesas Bluetooth® module, RY7011 that includes RL78/G1D device to 

evaluate for Bluetooth® communication. Thus, Sensor Panel board is suitable for developing a wireless communication 

platform. 

 

Figure 8  RL78/G1D device Hardware Programming/Debugging setting 

To build the RL78/G1D beacon firmware, you need e2 studio version 5.3 or later and the CCRL compiler v1.00.  

3.2.1 Importing the RL78/G1D Project in e2 studio Workspace 

1. To begin debugging, import the project (R5F11AGJ_Beacon) from the following folder and follow the 

procedure in section 3.1.1. 

 \..\Renesas_Sensor_Panel_Demo\ RL_project\uart_beacon\ 

Figure 9 shows the project in the e2 studio for Renesas Beacon firmware project.  

 

Figure 9  e2 studio with RL78 / G1D firmware project 

2. Select Rebuild All from the Project pulldown menu to build the project.  

The binary image output (R5F11AGJ_Beacon.hex) is placed in the following folder. 

\..\Renesas_Sensor_Panel_Demo\RL_project\uart_beacon\Project_Source\application\project\e2_cc\BL

E_Software\R5F11AGJ_Beacon 
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3.2.2 Debugging the RL78/G1D Project in e2 studio Workspace 

1. To enable debug function on Sensor Panel board for the RL78/G1D device, do the following (see Figure 10). 

The Sensor Panel board uses E1 as its programming/debugging interface.  

A. Attach the 14-pin connector (J9) to the E1 debugger unit.  

B. Supply power to the Sensor Panel Board using provided battery or +5 VDC Power via USB micro-B (J2).  

Figure 9 shows the debug setting with SEGGER J-Link debugger. 

 

Figure 10  e2 studio workspace in debugging mode for RL78/G1D 

2. Set the Debug configuration by selecting a project to debug. 

Figure 10 shows the Debug Configuration window.  

3. Select Debug Configuration from the Run pulldown menu.  

4. Right-click Renesas GDB hardware Debugging.  

5. Select New from the options menu to create a new debug launch.   

6. Select the Debugger tab (see Figure 6).  

7. Select E1/E20(RL78) for debug hardware and R5F11AGJ for Target Device.  

8. Click Debug to start debugging.   

Figure 11 shows the Debug window. Click Resume (F8) to run the program in Debug mode. 

  

Figure 11  e2 studio workspace in debugging mode for RL78/G1D  
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4. Programming to Sensor Panel 

4.1 Renesas Synergy™ S124 device 

Step 1. Attach the J-Link connector (J1) to the SEGGER J-Link debugger unit and attach PC USB connector 

via micro USB cable for power supply. See Figure 3. 

Note: Set up the Sensor Panel board with remove the shunt jumper at JP1 location.  

Step 2. Open J-Link Commander from Start menu in All Programs, SEGGER folder. 

 

Step 3. Enter the below commands to program target device. 

1. Device R7FS12477 

2. Speed 12000 

3. loadbin C:\...\ROM_File\file_name.hex, 0 

4. S 

 

Step 4. Note: This Healthcare Meters Kit includes following Hex files for respective modules 

a. The S7G2 Starter Kit (scanner) :  Security_Panel_S7.hex 

b. The S124 Sensor Panel (beacon):  Security_Panel_S124.hex 

 

Step 5. After programming, disconnect the board from the PC to evaluate.  

① 
② 
③ 

④ 
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4.2 RL78/G1D module (RY7011) 

To program the RL78/G1D Bluetooth®, you use the E1 programmer and perform the following steps:  

Step 1. Connect the Renesas E1 programmer/Debugger to connector J9 on the Sensor Panel board.  

See Figure 8 for connection. 

Step 2. To program RL78/G1D Beacon project output (R5F11AGJ_Beacon_SPB.hex), launch the Renesas 

Flash Programmer (RFP).  

See Figure 12 for applicable screens.  

Step 3. Create a new project. Select the RL78 device and set the power supply to 3.3 Volts. Click OK.  

Step 4. Select the Operation tab to load the program file (R5F11AGJ_Beacon_SPB.hex). 

Step 5. Click Start to begin to program.  

For details on RFP usage, refer to R20UT3841E.  

 

Figure 12  Renesas Flash Programmer 
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5. Circuit Diagram 

This section shows the Sensor Panel board schematics in total 6 sheets and RL78/G1D Module (RM-110-RFB-2) 

schematics in total one sheet. 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products 

 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. 

For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as 

well as any technical updates that have been issued for the products. 

 

1.  Handling of Unused Pins 

Handle unused pins in accordance with the directions given under Handling of Unused Pins in the 

manual. 

 The input pins of CMOS products are generally in the high-impedance state. In operation with 

an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

LSI, an associated shoot-through current flows internally, and malfunctions occur due to the 

false recognition of the pin state as an input signal become possible. Unused pins should be 

handled as described under Handling of Unused Pins in the manual. 

2.  Processing at Power-on 

The state of the product is undefined at the moment when power is supplied. 

 The states of internal circuits in the LSI are indeterminate and the states of register settings and 

pins are undefined at the moment when power is supplied. 

In a finished product where the reset signal is applied to the external reset pin, the states of 

pins are not guaranteed from the moment when power is supplied until the reset process is 

completed. 

In a similar way, the states of pins in a product that is reset by an on-chip power-on reset 

function are not guaranteed from the moment when power is supplied until the power reaches 

the level at which resetting has been specified. 

3.  Prohibition of Access to Reserved Addresses 

Access to reserved addresses is prohibited. 

 The reserved addresses are provided for the possible future expansion of functions. Do not 

access these addresses; the correct operation of LSI is not guaranteed if they are accessed. 

4.  Clock Signals 

After applying a reset, only release the reset line after the operating clock signal has become 

stable. When switching the clock signal during program execution, wait until the target clock signal 

has stabilized. 

 When the clock signal is generated with an external resonator (or from an external oscillator) 

during a reset, ensure that the reset line is only released after full stabilization of the clock 

signal. Moreover, when switching to a clock signal produced with an external resonator (or by 

an external oscillator) while program execution is in progress, wait until the target clock signal is 

stable. 

5.  Differences between Products 

Before changing from one product to another, i.e. to a product with a different part number, confirm 

that the change will not lead to problems. 

 The characteristics of Microprocessing unit or Microcontroller unit products in the same group 

but having a different part number may differ in terms of the internal memory capacity, layout 

pattern, and other factors, which can affect the ranges of electrical characteristics, such as 

characteristic values, operating margins, immunity to noise, and amount of radiated noise. 

When changing to a product with a different part number, implement a system-evaluation test 

for the given product. 

 



 

  

Notice
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for

the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by

you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other disputes involving patents, copyrights, or other intellectual property rights of third parties, by or

arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawing, chart, program, algorithm, application

examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages

incurred by you or third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics products.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended applications for each Renesas Electronics product depends on the

product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic

equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical

implantations etc.), or may cause serious property damages (space and undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas

Electronics disclaims any and all liability for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas

Electronics.

6. When using the Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, "General Notes for Handling and Using Semiconductor Devices" in the

reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat radiation

characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out of the use of Renesas Electronics products beyond such specified

ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics such as the occurrence of failure at a

certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please ensure to implement safety measures to guard them

against the possibility of bodily injury, injury or damage caused by fire, and social damage in the event of failure or malfunction of Renesas Electronics products, such as safety design for hardware and

software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures by your own responsibility as warranty

for your products/system.  Because the evaluation of microcomputer software alone is very difficult and not practical, please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please investigate applicable laws and

regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive carefully and sufficiently and use Renesas Electronics products in compliance with all

these applicable laws and regulations.  Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws

or regulations. You shall not use Renesas Electronics products or technologies for (1) any purpose relating to the development, design, manufacture, use, stockpiling, etc., of weapons of mass destruction,

such as nuclear weapons, chemical weapons, or biological weapons, or missiles (including unmanned aerial vehicles (UAVs)) for delivering such weapons, (2) any purpose relating to the development,

design, manufacture, or use of conventional weapons, or (3) any other purpose of disturbing international peace and security, and you shall not sell, export, lease, transfer, or release Renesas Electronics

products or technologies to any third party whether directly or indirectly with knowledge or reason to know that the third party or any other party will engage in the activities described above. When exporting,

selling, transferring, etc., Renesas Electronics products or technologies, you shall comply with any applicable export control laws and regulations promulgated and administered by the governments of the

countries asserting jurisdiction over the parties or transactions.

10. Please acknowledge and agree that you shall bear all the losses and damages which are incurred from the misuse or violation of the terms and conditions described in this document, including this notice,

and hold Renesas Electronics harmless, if such misuse or violation results from your resale or making Renesas Electronics products available any third party.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

http://www.renesas.com

Refer to "http://www.renesas.com/" for the latest and detailed information.
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